
U.S. DEPARTMENT OF THE INTERIOR 

U.S. GEOLOGICAL SURVEY

MudScan: PC Based Sidescan Sonar Real-time Data Acquisition,

Logging and Display System

by 

John T. Gann, Lawrence D. Kooker and Michael E. Boyle1

Open-File Report 93-242

Although this program has been used by the U.S. Geological Survey, no warranty, 
expressed or implied, is made by the USGS as to the accuracy and functioning of 
the program and related program material nor shall the fact of distribution 
constitute any such warranty, and no responsibility is assumed by the USGS in 
connection therewith.

This report is preliminary and has not been reviewed for conformity with U.S. 
Geological Survey editorial standards. Any use of trade, product, or firm names is 
for descriptive purposes only and does not imply endorsement by the U.S. 
Government.

1 U.S. Geological Survey Marine Facility, Redwood City, CA 94063



Table of Contents
Introduction......................................................................................................^
MainMudScan Display .....................................................................................5

Main Drawing Area.................................................................................5
Side Panel Display.................................................................................5
Scroll Window......................................................................................../

The File Menu................................................................................................... 7
Record....................................................................................................?
Playback.................................................................................................9
Print........................................................................................................9

The Edit Menu................................................................................................... 9
Navigation.............................................................................................. 10

Time Stamping Pings................................................................... 10
Throughput............................................................................................. 10
Sonar Range.......................................................................................... 11
Obstacle Avoidance............................................................................... 12
UTM Zone.............................................................................................. 13

The Display Menu............................................................................................. 13
LUT.........................................................................................................14
Gain........................................................................................................15
Channels................................................................................................ 15
Clear....................................................................................................... 16
Scale Lines............................................................................................. 16

The Printer Menu..............................................................................................16
Setup......................................................................................................17
Gain........................................................................................................17
Luts......................................................................................................... 18
Scale Lines............................................................................................. 19

MudScan Hardware Components..................................................................... 19
EG&G SMS 996 Digital Modem.............................................................. 19
MudScan i486 Rack Mount Digital Signal Processor.............................20
MudScan Digital Interface Box............................................................... 21
High Speed & High Resolution Graphics............................................... 23
Recording Media....................................................................................23

Index................................................................................................................. 24



List of Tables

Table 1 Side Panel Display Fields....................................................................?
Table 2 Automatic File Nomenclature............................................................... 8
Table 3 Range Scale Lines............................................................................... 16

List of Figures

Figure 1 Anatomy of Main MudScan Display.................................................... 5
Figure 2 File Menu............................................................................................7
Figure 3 File Dialog Box.................................................................................... 8
Figure 4 Edit Menu............................................................................................ 9
Figure 5 Navigation Source.............................................................................. 10
Figure 6 Throughput.........................................................................................11
Figure? Sonar Range....................................................................................... 11
Figure 8 Obstacle Avoidance............................................................................ 12
Figure 9 UTM Form........................................................................................... 13
Figure 10 Display Menu.................................................................................... 14
Figure 11 Display LUTs.................................................................................... 14
Figure 12 Display Gain..................................................................................... 15
Figure 13 Display Channels.............................................................................. 16
Figure 14 Printer Menu..................................................................................... 17
Figure 15 Printer Setup..................................................................................... 17
Figure 16 Printer Gain Control.......................................................................... 18
Figure 17 Printer LUTs...................................................................................... 19
Figure 18 MudScan System Diagram ............................................................... 20
Figure 19 MudScan Digital Signal Processor................................................... 21



Introduction
MudScan is a PC based data acquisition and display system designed for the 
EG&G SMS990/996 digital sidescan sonar system. MudScan software was 
developed using the Microsoft C/C++ 7.0 compiler under DOS 5.0. The system 
architecture is based on a J486-33 mHz ISA Bus industrial embedded PC 
compatible computer using a VGA monitor for the graphical user interface (GUI) 
and system control. The actual sonar data is displayed with a high performance 
Tl TMS34020-40mHz graphics coprocessor on a separate monitor. 
Sonar data is acquired as a background task using a parallel 10 board and the 
host DMA controller. MudScan records on any DOS disk media, although 
optical disk has proven to be best suited to the high logging rates and large 
volumes of data storage required. MudScan may be used to acquire sonar data 
directly from the SMS996 digital modem in real-time or it may be used to display 
and re-digitize sonar data from the EG&G SMS 960/Kennedy 9000 sea floor 
mapping system. This second mode of operation will allow data previously 
recorded from either the EG&G SMS 960/272 analog towfish or the SMS 
990/996 digital towfish and modem to be recorded in a computer compatible 
format for later processing and enhancement. Data originally recorded on the 
EG&G SMS 960/Kennedy 9000 system from either the analog or digital towfish 
cannot be computer processed, thus the need for a more advanced aquisition 
and processing system. In either mode of operation, MudScan will record sonar 
data in the QMIPS1 standard format that is compatible with other USGS 
developed mosaiking software.2 MudScan is fully compatible with the current 
USGS YoNav integrated navigation system3 Hard copy sonar record output is 
available in real-time or playback on the Raytheon TDU 850 thermal printer.

1 Triton Technology, Watsonvrlle, CA
2Open-File 92-XXX XSonar by Bill W. Danforth, AMG
3Open File 92-565 YoNav: Your Own Navigation System by John T. Gann
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Figure 1. Anatomy of Main MudScan Display

Main MudScan Display
The main graphics display is comprised of 3 different windows: 1) 
the main drawing area, 2) the side panel display and 3) the scrolling 
message area in the lower right comer. Each part of the display 
serves a discrete function. Please refer to Figure 1. while reading 
the next few sections.

Main Drawing Area
The main drawing area optionally displays an operator controlled 
obstacle avoidance form. See Figure 1. The Obstacle Avoidance 
display is discussed in the Edit Menu section.

Side Panel Display
The side panel display is used to display the navigation, sonar and disk related 
parameters during both real-time and playback modes. See Figure 1. Starting 
at the top of the form, the time, latitude and longitude are displayed for the 
current ping. The other fields are described in Table 1.



Field 
Label
SMG

CMG

HDG

SDEP

CRO

ALO

END

FDEP

PNG

RNG

FIL
SIZ

Free

Description

Speed Made 
Good
Course Made 
Good
Fish Compass 
Heading
Bottom depth 
under ship

CROss track 
distance from 
current survey 
line.
ALOng track 
distance 
measured from 
start of current 
survey line.
Distance to END 
of current survey 
line
Depth of sidescan 
sonar fish as 
measured by 
onboard pressure 
transducer
Sequential ping 
number since the 
beginning of file
Current sidescan 
swath width

Current Filename
Size of the 
current file
Amount of disk 
space remaining 
on the current 
drive

Units

Knots

Degrees

Degrees

Meters

Meters

Meters

Meters

Meters

Unitless

Meters

Unitless
Megabyt 
es
Megabyt 
es

Source

YoNav

YoNav

Sidescan sonar 
fish
YoNav via 
shipboard 
bathymetry 
sensor.
YoNav

YoNav

YoNav

Sidescan sonar 
fish

MudScan System

Computed by 
MudScan using 
raw sidescan data
MudScan
MudScan

MudScan

Table 1. Side Panel Display Fields



Scroll Window
The Scroll Window at the lower right hand corner of the screen is used to display 
informational and diagnostic messages from MudScan to the operator.

The File Menu
The File Menu contains selections for configuring MudScan in 
Record, Playback or Test Mode as well as providing the means to 
exit to DOS. Please refer to Figure 2.

Edit Display Printer

Record 
Playback 
Print 
exit

Figure 2. File Menu

Record
The Record menu selection allows the operator to begin the real-time recording 
of sidescan sonar data either from the SMS 996 modem or directly from the 
Kennedy 9000 tape drives. When recording real-time sidescan data from the 
SMS 996 modem be sure that the MudScan Interface Panel switch has been set 
to the SMS 996 Modem/Real-time position. When recording from the Kennedy 
9000 tape drives the switch must be in the Tape Read position. 
When the Record selection is chosen the operator is presented with a 
destination file dialog box. Please refer to Figure 3.



Select Destination Filename

Drive | EL!
Directory | J\

FileSpec 1

Okay |

(93Q32417.DAT

Default} Cancel | Help | Find |

Figure 3. File Dialog Box

The file dialog box provides a consistent way to select files for input or output. 
The Drive button may be pressed to select a logical disk drive or the drive letter 
(followed by a colon) may be entered directly into the drive field area. The 
Directory button may be pressed to give a list of directories on the current drive 
or the directory path may be entered in the directory field. The FileSpec button 
may be pressed to get a list of all the files in the current directory that match the 
contents of the file specification field. Normal DOS wild card characters may be 
used to match a certain pattern of files. For example, to find all of the files in the 
directory that end with the "DAT1 suffix, type "*.DAT" as the file specification and 
press either the Okay or File§pec buttons. The Find button will search the 
entire drive for a file that matches the file specification field. Note that on large 
disk drives the Find function may not have enough memory to provide a 
complete list of directories or filenames.

The file dialog box will contain a suggested filename in which to store the 
recorded sonar data. The filename format is shown in Table 2as follows:

YYMMDDHH.nnn 
where,
Symbol
YY
MM
DD
HH
nnn

Description
current Year
current month
current day of month
current hour of day
required to create a unique file name

Range
00-99
01-12
01-31
00-23
"DAT1 or 001 -999

Table 2. Automatic File Nomenclature
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The suggested file name, which is based on the current time and date, is 
guaranteed to be a unique filename on the current logging disk. You may accept 
this unique filename or replace it with another. The automatically generated 
filenames are recommended because they provide a way of time stamping the 
recorded data. These filenames can also be chronologically sorted for playback 
or mosaic creation.

Playback
The Playback menu selection allows the operator to begin playback of 
prerecorded sonar data that is in the QMIPS format A File Dialog box is 
presented to allow the user to choose the file to playback. During Playback, the 
Pg Up and Pg Dn keys may be used to "fast-forward" and "fast-reverse" through 
the file to find a desired feature. Playback may be used to print sections of data 
on the Raytheon Thermal printer. However, if you wish to print the entire file, the 
Print option (next section) is a much faster way to do this. (See the section on 
Throughput).

Print
The Print menu selection allows the operator to print a prerecorded sonar data 
file on the Raytheon TDU-850 thermal printer. This is the fastest way to get a 
hard copy of a sonar data file. (See the section on Throughput).

The Edit Menu
The Edit Menu contains selections for configuring various MudScan 
operating parameters. Please refer to Figure 4.

File Display Printer

Navigation 
Throughput 
Sonar Range 
Obstacle Avoidance 
UTM Zone

Figure 4. Edit Menu

The Edit Menu allows the operator to select the navigation input 
source, change the system throughput, manually change the input 
sonar range, setup the obstacle avoidance display and set the 
MudScan UTM Zone.



Navigation
The Navigation menu selection allows the operator to setup a navigation input
function. See Figure 5.

Set Navigation Source
*

vjj YoNav USGS Nav System

3 No Navigation Input

Figure 5. Navigation Source

The only options that are currently supported are the No Navigation and the 
YoNav"1 input options. The COM1 serial port is assigned to the navigation input. 
YoNav should be configured to output the MudScan data packet at 9600 baud, 
no parity 8 data bits and one stop bit.

Time Stamping Pings
If using MudScah without a navigation input be certain that the MudScan system 
time is synchronized with non-integrated navigation sensor so the sonar data 
can be correlated to the navigation data through accurate time stamping. 
MudScan time stamps each ping to the nearest millisecond. Since the data 
arriving from the sonar is not blocked by pings, a different approach was taken 
to time stamp each ping. Since a large block of sonar data is transferred to 
system memory during one data acquisition cycle, the sonar data block receives 
a single time stamp. The time for each ping within the sonar data block is 
computed by adding the milliseconds of delay between each sonar ping at the 
current sonar range.

Throughput
The Throughput menu selection allows the operator to set the speed at which 
the sonar data will be read and displayed during Playback. The actual Ping 
Throughput number is the number of pings that will be read in from the disk 
during a single read operation. Lower numbers result in a smoother yet slower 
waterfall display. Higher numbers give a jerkier yet faster playback. In either 
case every recorded ping will be displayed. Please refer to Figure 6.
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I

Figure 6. Throughput

The Throughput option has no effect during Record mode. In general, the higher 
the throughput number, the more pings that will be processed during playback. 
The throughput number is limited by available PC memory.

Sonar Range
The Sonar Range menu selection allows the operator to manually set the
expected sonar range. Please refer to Figure 7.

Select Sonar Range^ Scale

J

  ,11 --

vjise"

1
1
1

208

380

400

 

*

Figure 7. Sonar Range

The sonar range is half the current swath width of the side scanning sonar. This 
should be set prior to entering the record mode and has no effect during 
playback mode. MudScan will detect the incoming sonar range by looking at the 
number of samples per channel that are being acquired as long as the SMS 
990/996 system is being operated in the fixed sampling frequency mode. In this 
mode, the SMS 996 digitizer operates at 6 kHz per channel so that each
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different sonar range will produce a distinct number of samples.4 If MudScan 
detects a change in the current sonar range scale during a recording session, it 
will automatically close the current file, open a new file on the current logging 
disk drive and restart the record mode. This built-in detection feature allows the 
sonar operator to change range scates at any time without worrying about 
changing the range scale on the MudScan system.

Obstacle Avoidance
The obstacle avoidance form is provided as an aid to determining 
the location of the towed sidescan sonar with respect to the bottom. 
Please refer to^Figure 8.

Obstacle Avoidance

Enabled

Fish Layback (m) 1100 

Horizontal Scale (m) 1100

Vertical Scale (m) 1508t
Top Window Depth (m) 10

Okayj Cancel|

Figure 8. Obstacle Avoidance

The SMS 990 fish contains a hydrostatic pressure transducer that 
reports the depth of the fish. The depth under the towing vessel as 
well as the vessels' speed is used to complete the collision 
avoidance display. The fish icon will be positioned both horizontally 
and vertically according to the horizontal and vertical scales selected 
and the depth of the fish. The arrow icon will draw a line horizontally 
that represents the bottom depth under the ship. The fish layback 
value is used to horizontally position the fish within the collision 
avoidance window. NOTE: This display is provided as an aid

4MudScan has not been tested with the SMS 990/996 in variable digitizer frequency mode, but 
should work. The automatic range detection algorithm will always select a range of 100 meters 
(884 samples per channel). The reason for this is that in variable sampling frequency mode, 
both the SMS 990/996 and SMS960/272 always send out the same number of samples 
regardless of sonar range and that number of samples (884 / channel) is the same as the fixed 
frequency 100 meter range scale.
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only! Since this form is only as accurate as the bathymetry, fish 
depth sensor and layback information provided, always use 
independent means to verify the location of the fish.

UTM Zone
In order to properly record navigation data in the QMIPS format, the 
Universal Transverse Mercator (UTM) Zone number is required. The 
UTM Zone for the given operating area can be obtained from the 
YoNav system or from most mapping text books. See Figure 9

Default UTM Zone

Ul 

I

*

FM Zone Number

JTM Zone Letter

18

S

Okay j Cancel 1

Figure 9. UTM Form

YoNav passes navigation information as latitude and longitude in the 
WGS84 datum. The QMIPS format specifies that the navigation 
information be recorded in UTM coordinates. NOTE: If the latitude 
and longitude displayed on the MudScan side panel does not agree 
with the YoNav display, it is most likely because the UTM zone 
number and letter have not been properly set in MudScan.

The Display Menu
The Display Menu contains selections for configuring the MudScan 
high resolution graphics display. Please refer to Figure 10.
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File Edit

LUT 
Gain
Channels 
Clear 
Scale Lines

Figure 10. Display Menu

LUT
The LUT menu selection allows the selection of a color display Look Up Table 
(LUT). The primary value of a LUT is to allow the graphics hardware to display 
the same digital image in various analog presentations by controlling the way the 
graphics hardware will respond to a certain digital value. The LUT instructs the 
graphics hardware how much red, green and blue to display for a certain digital 
value.
The user is presented a list of LUT files for the TiGA display and may choose 
the desired LUT from a list of suitable LUT files. See Figure 11

Tiga Luts

AAA.LUT
AFA2.LUT
ALGAEIUT
BBGWYRD1UT
BGV.LUT
BGVR.LUT
BGVR1.LUT

Figure 11. Display LUTs

The chosen LUT file will be immediately applied and its effects visible on the 
high resolution graphics display. The LUT can be changed at any time, during 
record, playback or idle mode. The LUT can be rotated to the left or the right
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through the use of the Alt-F4 and Alt F5 function keys. The LUT can be inverted 
by pressing the Alt-F3 function key.

Gain
The Gain menu selection allows the operator to apply a digital gain the raw 
sonar sample before displaying it. Since both the EG&G SMS 960 and SMS 
990/996 use a 6-bit digitizer all digital sonar values will be in the range of 
decimal 0-63. Use the gain control to select the number of bits to "shift" the raw 
display. Please see Figure 12.

Display Gain3its

B 0 Bits _= . ^

J

"

1 Bit

2 Bits

3 Bits

1 4 Bits

B 5 Bits 
-r=    

Figure 12. Display Gain

A shift is a multiplication by 2n » where n is the display gain value. For example, 
if the display gain is set 3 bits and the raw sonar sample is 25, then the display 
will respond as if the sample was 200 (23 X 25). The gain value has no effect on 
the recorded data. It's only function is to enhance the graphics display. The 
recorded data is always written in its full raw format regardless of any display 
option setting.

Channels
The Channels menu selection allows the display of either Port & Starboard, Port
Only or Starboard only sonar channels. See Figure 13.
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Set Display ChanneIs

JPort & Starboard

JPort Only

J Starboard Only

Figure 13. Display Channels

This option only affects the high resolution display. It has no effect on the hard 
copy display or the recorded data. The recorded data is always written in its full 
raw format regardless of any display option setting.

Clear
The Clear menu selection clears the high resolution graphics display. This 
option only affects the high resolution display. It has no effect on the hard copy 
display or the recorded data.

Scale Lines
The Scale Lines menu selection displays 5 proportional scale lines on the high 
resolution display. The scale lines will be displayed when the menu item is 
checked. See Table 3

Sonar Range Scale
100
150
200
300
400
500

Distance Between Scale Lines (m)
20
30
40
60
80
100

Table 3. Range Scale Lines

The Printer Menu
The Printer Menu contains selections for configuring the Raytheon 
TDU-850 thermal printer for hard copy output of sonar records in 
both record and playback modes. Please refer to Figure 14.
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File Edit Display

Setup 
Gain 
Luts 
Scale Lines

Figure 14. Printer Menu

Setup
The Setup menu allows the operator to select what channels, if any, to display 
on the Raytheon TDU-850. Please refer to Figure 15.

Raytheon TQU-85G Setup

VI Off

I Port & Starboard

JPort Only

Starboard Only

Figure 15. Printer Setup

The printer can display either port and starboard, port only or starboard only 
sonar channels. This option only affects the hard copy output. It has no effect 
on the high resolution video display or the recorded data. The recorded data is 
always written in its full raw format regardless of any printer option setting.

Gain
The Gain menu selection allows the operator to apply a digital gain the raw
sonar sample before printing it. See Figure 16.
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Figure 16. Printer Gain Control

Since both the EG&G SMS 960 and SMS 990/996 use a 6-bit digitizer all digital 
sonar values will be in the range of decimal 0-63. Use the printer gain control to 
select the number of bits to "shift" the raw display. A shift is a multiplication by 
2n > where n is the display gain value. For example, if the printer gain is set 3 
bits and the raw sonar sample is 25, then the printer will respond as if the 
sample was 200 (2^ X 25). The gain value has no effect on the recorded data. 
It's only function is to enhance the hard copy output. The recorded data is 
always written in its full raw format regardless of any printer option setting.

Luts
The Luts menu selection allows the selection of a gray scale LUT. Please refer
to Figure 17.
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AFA2TDU 
ALGAE.TDU 
BBGWVRDTOU 
BGY.TDU

Figure 17. Printer LUTs

The user is presented a list of LUT files for the Raytheon TDU-850 and may 
choose the desired LUT from a list of suitable LUT files. The chosen LUT file 
wilt be immediately applied and its effects visible on the next printed sonar ping. 
The LUT can be changed at any time, during record, playback or idle mode. The 
printer LUTs differ from the display LUTs in that the printer is a black and white 
device not a color device. The LUT files for the printer were developed by taking 
the color display luts and mapping the red intensities to gray levels for each of 
the 256 entries.

Scale Lines
The Scale Lines menu selection displays 5 proportional scale lines on the 
thermal printer output. The scale lines will be displayed when the menu item is 
checked. See Table 3 for the size of the scale line increments.

MudScan Hardware Components

EG&G SMS 996 Digital Modem
The data for real-time operation of MudScan comes from the SMS 996 Modem. 
Data frame synchronization is accomplished with a 12 kHz strobe signal and by 
having the two most significant bits of each 8-bit serial data word coming up the 
coax telemetry cable encoded with the type of data sent. The lowest six bits are 
actual data bytes. For the port and starboard data, each byte is one 6-bit word. 
For the sensor data, each pair of bytes makes up a 12-bit word. The high 
frequency up-link data are received by a UART (Universal Asynchronous 
Receiver Transmitter) and converted back into parallel data for export to the
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outside world. The parallel outputs of the modem are negative true open 
collector logic and are not suitable for direct importation into a computer based 
data acquisition and processing system. A custom interface was designed and 
built for bringing the digital data stream from either the EG&G SMS 990/996 or 
Kennedy 9000 9 track tape system into MudScan.

MudScan i486 Rack Mount Digital Signal Processor

The MudScan i486 digital signal processor is an ISA Bus embedded PC 
compatible computer running at 33 MHz. It is constructed with an active 
motherboard utilizing industry standard off-the-shelf components. Refer to 
figure18

Haxdcopy Output: 
HPPaiti^et or 
Raytheon TDU 850 
256 Qteyscak Thetmal

-BaddbaJ

t t
BomSMSMxtem KomRajoedy 9000 Tape ^stem

jijr _ict«^_ Sfefe SeenSoncrDataAquisition tfysteMidScan ^kD^n
Figure 18. MudScan System Diagram
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MudScan Digital Interface Box
MudScan comes equipped with a digital interface box that contains circuitry for 
two functions. Refer to Figure 19 while reading this section.
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Figure 19. MudScan Digital Signal Processor

The main circuit transforms the parallel data into TTL level positive true logic 
levels. This is accomplished by pulling up the modem open collector outputs and 
inverting all data and Xfer request (strobe) lines. The second printed circuit 
board performs signal routing and data switching functions to allow for selecting 
between real-time input from the SMS 996 Modem or re-digitizing tapes from the 
Kennedy 9000 tape system to allow for later image processing and computer 
generated mosaics. The interface box has a front panel radial knob for selecting 
either input function. The rear of the interface box has two DB-25 pin connectors 
that mate with a standard parallel data cable to both the SMS 996 Modem and 
the Kennedy 9000 tape deck. Also on the rear of the interface is a DB-37 pin 
connector that mates with a 37 line flat ribbon cable to bring the parallel data 
into the MudScan via the PDMA-32 PCS assembly.
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High Speed & High Resolution Graphics
The high resolution graphics display is produced by using the Number Nine GXi 
Level 25 graphics board. This single board contains both a standard VGA 
adapter as well as a high resolution (1280 X 1024 X 256) graphics co-processor 
(Texas Instruments TMS34020). MudScan uses the VGA graphics monitor to 
provide an easy to use Graphical User Interface (GUI) while displaying the sonar 
data on the high resolution display. The sonar display software takes 
advantage of the Texas Instruments Graphics Architecture (TIGA) driver and 
should be portable to any other video card that supports the TIGA interface.

Recording Media
MudScan uses a Sony Rewritable Magneto Optical SCSI disk for .recording the 
voluminous amounts of sidescan sonar data. The MudScan software will record 
to any standard DOS device such as a standard hard or floppy drive but typically 
these devices do not have sufficient volume for sidescan applications. 
The advantages to using rewritable disks is both the ability to recycle the rather 
expensive optical disk media and the rapid disk access times.
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